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About this guide

This guide includes the following information:

• Product information that you need to get started using the current 

release of Vicon Tracker

• New features and functionality included in Tracker 3.7.

• Prerequisites and any limitations

• Known problems

For information on installing and licensing, see Installing and licensing 

Vicon Tracker, in the Vicon Tracker User Guide.

For further assistance, please contact Vicon Support1.

mailto:support@vicon.com
mailto:support@vicon.com
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About Vicon Tracker

Vicon Tracker is a powerful object-tracking solution, providing unrivaled 

data accuracy for integration into 3D applications. It enables you to use 

Vicon camera hardware for tracking rigid bodies, accurately streaming 6 

Degree of Freedom data in real time with very low latency.

Tracker 3.7 is a point release that includes several new features and 

enhancements. Details of the new features of Tracker 3.7 are described in 

Tracker 3.7 new features and functions (page 9). 

For information on preparing to use the latest version of Tracker, see:

• Requirements for Vicon Tracker (page 5)

• Install Vicon Tracker (page 6)

• About Vicon Tracker licensing (page 7)
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Requirements for Vicon Tracker
Tracker 3.7 is supported under the following operating systems:

• Microsoft Windows 10, 64-bit (this is the Vicon-recommended OS): 

Compatible with and fully supported. Installation, software operation and 

required third-party drivers tested.

• Microsoft Windows 7: Supported and has undergone limited testing.

Although Tracker may install and function under other Microsoft Windows 

operating systems, this is not officially supported or recommended by 

Vicon.

Tracker works with data from Vicon systems (including Vicon Vero, 

Vicon Vantage and MX T-Series cameras and units, and Vicon Bonita 

cameras). It is also compatible with the Vicon Virtual System, enabling you 

to integrate it into your software without having to use a camera system.

License servers
If your organization licenses its Vicon product(s) from a server, ensure that 

the server meets the following criteria:

• It is unlikely to be powered down.

• It has a static IP address, so client machines can find it easily and 

reliably.

• It is unlikely to have its hardware configuration changed, especially the 

HDD and NICs.

 Tip
A pre-existing server in your organization is likely to fulfill the 

above criteria.
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Install Vicon Tracker
Tracker 3.7 automatically installs into its own (Tracker3.7) folder, so your old 

Tracker installation is unaffected. Any old files that you choose to import 

into Tracker 3.7 are copied from their original locations, leaving the 

originals untouched.

The procedure for installing Tracker is the same as that for other Vicon 

products. 

To install Tracker: 

1. Download and extract the appropriate installation file from the Vicon 

web site2.

2. Double-click the installation file.

Before proceeding with installation, Tracker 3 automatically scans for 

Tracker 2.x files, displays a list of any older files that it finds, and 

provides an automated system for importing these into Tracker 3. This 

process copies all the old files and converts the copies, ensuring that 

original files are not moved, altered, or destroyed.

3. Follow the instructions on each wizard page, completing the required 

details.

The Tracker 3.7 installer enables optional installation of the License 

Server software for server-based licensing, and the dongle drivers for 

licenses that are locked to dongles.

For information on the licensing utility (VAULT), see License Vicon Tracker

in the Vicon Tracker User Guide.

If you are prompted to restart your PC, do so as soon as possible.

https://www.vicon.com
https://www.vicon.com
https://www.vicon.com
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About Vicon Tracker licensing
Vicon Tracker 3.7 uses Safenet licensing and a built-in licensing utility (the 

Vicon Automated Unified Licensing Tool – VAULT).

You specify the license server via a dialog box that appears if no license is 

found or via the Help > Vicon Product Licensing menu option. The server 

name is stored in the following file under Windows 10:

  <InstallationDrive>:
\Users\Public\Documents\Vicon\Licensing\TrackerLicInfo#.xml

If you need to view information about licensing while you are using Tracker, 

on the Help menu, click Vicon Product Licensing.

For detailed instructions on how to use VAULT, see License Vicon Tracker in 

the Vicon Tracker User Guide.
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New features and functions

The following topics provide a summary of the new features of 

Vicon Tracker 3, beginning with the most recent changes.

• Tracker 3.7 new features and functions (page 9)

• Tracker 3.6 new features and functions (page 14)

• Tracker 3.5 new features and functions (page 20)

• Tracker 3.4 new features and functions (page 23)

• Tracker 3.3 new features and functions (page 29)

• Tracker 3.2 new features and functions (page 41)

• Tracker 3.1 new features and functions (page 51)

• Tracker 3.0 new features and functions (page 63)
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Tracker 3.7 new features and functions
New features including the following have been added to Vicon Tracker 3.7:

• Improved calibration volume reproducibility (page 9)

• Automatic notification of firmware updates (page 10)

Improved calibration volume reproducibility
To achieve maximum positional reproducibility of the Vicon coordinate 

system, you can create a large custom L-Frame object from markers 

permanently placed around the edge of the capture volume. You can then 

use this L-Frame object for subsequent setting of the system origin.

This provides a high degree of precision of the coordinate system across 

the camera calibration.

To help with this, select the new Auto Scale option when you set the origin, 

as described below.

This improves the consistency of the volume size, further improving the 

positional reproducibility.
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To perform a calibration with rescale:

1. Calibrate the system as usual (see Calibrate Vicon cameras).

2. Create an L-Frame object from reconstructed markers (see Creating an 

object), which spans the whole volume, and set the translation to 

(0,0,0).

Note that the L-frame must be constructed from a permanent 

arrangement of markers that are spread as far apart as possible, without 

being poorly reconstructed by being too far out of the volume.

3. In the Set Origin section, select the  L-Frame.

4. Select Auto Scale.

5. Click Start.

The system scale is adjusted to provide improved positional 

reproducibility.

Automatic notification of firmware updates
You are now automatically notified when any component of your Vicon 

system is running out-of-date firmware, and given the opportunity to 

update to the latest version.

To monitor and/or upgrade system firmware:

1. When you start Tracker or connect any Vicon devices into your system, 

Tracker checks to see whether the firmware for all your devices is up-to-

date.

If your devices aren’t using the latest firmware, Tracker displays an icon 

in the toolbar to let you know that a more up-to-date version of the 

firmware is available: 

Important

To ensure optimum performance and access to all the latest 

functionality, Vicon recommends that you upgrade to the latest 

firmware whenever it becomes available.
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2. Click on the icon to display more information.

Tracker displays a prompt that enables you to open the Vicon Firmware 

Update Utility (reprogramming tool).

 

3. Click Yes to open the Vicon Firmware Update Utility. Note that you can 

also open the Vicon Firmware Update Utility from the Start menu (select 

Vicon > Vicon Firmware Update Utility).

Tracker closes and the Vicon Firmware Update Utility is displayed, 

showing all the connected devices and their current firmware version.

By default, all devices are selected. 
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4. If you don’t want to update any of the devices, clear the relevant check 

box(es). 

Note that if required, you can select devices to be updated that are 

already using the latest version.

5. At the bottom of the Vicon Firmware Update Utility window, in the 

Choose Firmware version list, select or browse to the required firmware 

version.

6. Click Reprogram to update the firmware for the selected device(s).

When updating is complete, the Firmware Version column displays the 

updated firmware version and the System Status line and the 

Reprogramming Status column display Complete on a green 

background.
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To downgrade to an earlier firmware version

To downgrade to a firmware version that was previously downloaded, open 

the Vicon Firmware Update Utility (from the Start menu click Vicon > Vicon 

Firmware Update Utility) and select the required firmware version.

Note

If you do not have continual internet access, Tracker is unable to 

notify you when a new version of the system firmware is available. 

In this case, install the Vicon Firmware Update Utility on an 

internet-connected machine to detect and download the latest 

version of the firmware. You can then transfer this download to the 

local machine and use the Vicon Firmware Update Utility to update 

to the latest version of the firmware.
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Tracker 3.6 new features and functions
New features including the following have been added to Vicon Tracker 

3.6:

• Tracker 3.6.1 new features (page 15)

• Tracker 3.6 new features (page 17)
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Tracker 3.6.1 new features
The following enhancements were added to Vicon Tracker 3.6.1:

• • Entrance Threshold can now be per object type (page 15)

• System synchronization from 100 Hz square wave (page 16)

Entrance Threshold can now be per object type

Location: Resources pane > Objects tab > Object Type Preset section > 

Manage Presets > Objects Presets dialog box

You can now define an Entrance Threshold (the minimum proportion of 

markers that must be visible to the cameras before the object is booted) 

per object type in the Object Presets dialog box, instead of having to apply 

it globally for all objects.

To apply an Entrance Threshold to an object:

1. On the Objects tab, in the Object Type Preset section, click Manage 

Presets.

2. In the Object Presets dialog box, create a new preset and in the Object 

Tracking section, specify the require Entrance Threshold.



What's new 
in Tracker 
3.7? 

New features and functions

Vicon Motion Systems Ltd. 22-Oct-2018 Page 16 of 95

3. On the Objects tab, select the object to which you want to apply the 

preset.

4. In the Object Type Preset section, select the preset that you created.

System synchronization from 100 Hz square wave

The VESA sync input on Vicon Lock devices now supports the connection 

of a 100 Hz square wave signal for synchronizing the Vicon system to an 

external clock.

The signal must be 5V peak, with a 50% duty cycle.

The following diagram shows the front view of a VESA sync input, which is 

a 3-pin mini-DIN socket.
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Tracker 3.6 new features
The following new features were added to Vicon Tracker 3.6:

• • Improvements to tracking (page 17)

• Easier checking for firmware updates (page 17)

• Motion Model filter for selected objects (page 18)

• 32-bit version of Tracker (page 19)

• Disable/enable camera strobes (page 19)

Improvements to tracking

Several improvements to tracking include:

• The ability to resolve objects that are close together now enables very 

small objects to be tracked when they are closer than 10 mm.

• Greater intelligence in the centroid-fitting of data minimizes the impact 

of large reflections on latency of the system.

• More robust centroid-fitting with objects that are closely similar.

Easier checking for firmware updates

Location: Help > Check for firmware updates 

Tracker provides a quick and easy way to check when new firmware is 

available for your cameras.

To check the latest release firmware version:

• On the Help menu, click Check for Firmware Updates.

The Checking Firmware Version dialog box displays information about 

the latest released firmware version.
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To check the firmware that your system is using:

• Ensure the system is in Live mode, and in the System Resources pane, 

right-click Local Vicon System and then click Reprogram Vicon Firmware.

The firmware version currently used by your system is displayed in the 

Version column for every connected device.

To download the latest firmware, visit www.vicon.com/downloads/utilities-

and-sdk/camera-firmware3.

You can then update your firmware using the Reprogram Firmware dialog 

box.

Motion Model filter for selected objects

Location: Resources pane > Objects tab > Object Type Preset section > 

Manage Presets > Objects Presets dialog box

You can now apply the Motion Model filter, which enables Tracker to detect 

static objects, to individual objects.

To enable Tracker to detect an object as stationary:

1. On the Objects tab, in the Object Type Preset section, click Manage 

Presets.

2. In the Object Presets dialog box, create a new preset and select Motion 

Model.

http://www.vicon.com/downloads/utilities-and-sdk/camera-firmware
http://www.vicon.com/downloads/utilities-and-sdk/camera-firmware
http://www.vicon.com/downloads/utilities-and-sdk/camera-firmware


What's new 
in Tracker 
3.7? 

New features and functions

Vicon Motion Systems Ltd. 22-Oct-2018 Page 19 of 95

3. On the Objects tab, select the object that you want Tracker to detect as 

stationary.

4. In the Object Type Preset section, select the preset that you created.

32-bit version of Tracker

A version of Tracker 3.6 that runs under 32-bit Microsoft® Windows® is now 
available.

To obtain the 32-bit version, please contact Vicon Support.

Disable/enable camera strobes

Location: System Resources pane > Vicon Cameras node > Vantage or Vero 

camera(s) selected > Properties pane > Settings section

A new Enable Strobe setting enables you to disable or enable strobes on 

Vantage or Vero cameras without affecting the shutter period.

Note

Vicon recommends the use of the 64-bit version of Tracker, but the 

32-bit version is provided to enable Tracker to be used on older PCs. 

However, the 32-bit version is provided as-is and with no guarantee 

of support.
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Tracker 3.5 new features and functions
New features including the following have been added to Vicon Tracker 3.5:

• New hotkeys option (page 21)

• Display of third-party license information (page 22)

• Lens model improvements (page 22)

Note

Calibrations generated with Tracker 3.5 cannot be used in previous 

versions of the software.
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New hotkeys option
Location: Help menu > Hotkeys

To prevent accidental loss of tracking, you can now choose whether to use 

the spacebar to pause the system. To access this option along with other 

hotkeys, on the Help menu, click Hotkeys.

In the Hotkeys dialog box, select or clear the options as required.
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Display of third-party license information
Location: Help menu > Show 3rd party licenses

To display third party license information, on the Help menu, click Show 3rd 

party licenses.

A dialog box, similar to the following, is displayed. Scroll down to see 

license information for all relevant third-party software:

Lens model improvements
The lens model in Tracker has been extended to work more robustly with 

lenses that have a high degree of distortion.
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Tracker 3.4 new features and functions
New features including the following have been added to Vicon Tracker 

3.4:

• Recalibrate marker positions (page 24)

• Work with grouped objects (page 25)
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Recalibrate marker positions
Location: Resources pane > Objects tab > Add Marker to Object area

If a calibrated object becomes distorted due to a marker having been been 

lost and replaced in a slightly different position from its original location, 

you can use the Recalibrate button to update the marker position.

The Recalibrate button enables you to recalibrate the object at the current 

pose, updating the marker position without affecting the pose of the 

object.

To recalibrate a marker:

1. Select the marker that has been replaced, or whose position has moved 

slightly.

2. On the Objects tab, click the Recalibrate button.

The marker position is updated, but the object's orientation and the 

other markers are unaffected.
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Work with grouped objects
Location: Resources pane > Objects tab

The ability to act on multiple objects simultaneously is useful when you are 

working with similar objects, such as the collection of rigid bodies that 

make up a single subject.

You can group objects and then select the group, so that activation, 

selection, and deletion applies to all objects in the selected group.

For more information, see:

• Create a group (page 26)

• Add objects to a group (page 26)

• Activate and deactivate grouped objects (page 27)

• Select grouped objects (page 27)

• Ungroup or delete grouped objects (page 27)

• Change the color of grouped objects (page 28)

• Save grouped objects (page 28)
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Create a group

To create a group of objects:

1. On the Objects tab, click to select the required objects, then right-click 

and on the context menu click Group Objects.

2. Enter a name for your group and click OK.

The selected objects are grouped under the new group name:

You can create further groups of objects as required.

3. To see the objects in a group, expand the group by clicking the arrow to 

the right of the group name. By default, all objects in the group are 

activated:

Add objects to a group

To add objects to an existing group:

On the Objects tab, right-click the name of the object that you want to add 

to the group, point to Add to Group, and then click the name of the 

required group.
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Activate and deactivate grouped objects

To activate/deactivate objects

On the Objects tab, you can activate/deactivate grouped objects in either 

of these ways:

• All objects in a group: Clear or select the check box to the left of the 

group name.

• One or more objects within a group: Expand the group and clear or 

select the check box to the left of the object name.

The check box to the left of the group name changes to reflect the 

activation status of objects within the group.

Select grouped objects

To select grouped objects

When you select a group (that is, click its name on the Objects tab), all the 

objects in the group are selected by default:

You can also click, SHIFT-click and CTRL-click to select/deselect one or 

more objects within the group.

Ungroup or delete grouped objects

To ungroup or delete objects

On the Objects tab, you can ungroup and/or delete grouped objects in 

either of these ways:

• All objects in a group: Right-click the group name and click the required 

option:

• Delete permanently deletes the group and all the objects within it.
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• Ungroup moves all the group's objects outside the group and lists them 

separately on the Objects tab. The group name is no longer displayed.

or

• One or more objects within a group: Expand the group, right-click the 

required object(s) and then click the required option:

• Delete Object permanently deletes the object.

• Remove Object from GroupName moves the object from within the 

group to outside the group, so that it is listed separately on the 

Objects tab.

Change the color of grouped objects

To change the color of grouped objects

1. On the Objects tab, select a group by clicking its name.

2. In the Properties pane, click the group's Color box.

3. In the Select Color dialog box, choose the required color.

The color of all the objects in the selected group changes.

Save grouped objects

To save grouped objects:

On the Objects tab, expand the group, right-click the object and click Save 

Object.
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Tracker 3.3 new features and functions
New features including the following have been added to Vicon Tracker 3.3:

• Compatibility with Vicon Vero cameras (page 30)

• Derivatives included in VRPN output (page 39)

• Quaternion output for CSV export (page 40)
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Compatibility with Vicon Vero cameras
The latest version of Tracker is compatible with Vicon's new Vicon Vero and 

Vicon Vue cameras, enabling you to benefit from their speed, flexibility and 

affordability.

Vicon Vero includes two optical camera models: 2.2, which can provide up 

to 330 fps with 2.2 megapixel resolution; and 1.3, which offers up to 250 

fps with 1.3 megapixel resolution.
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Vicon Vero cameras are fitted with: 

• Side-mounted status LEDs on both the camera and the strobe, which 

give clearly visible camera status information. For more information, see 

Vero camera status LEDs (page 32).

• An accelerometer, which enables you to select a camera in the volume by 

tapping it, and which monitors the camera position to alert you if any 

cameras are accidentally knocked or moved from their intended 

positions. For more information, see Vero Tap to Select feature (page 34)

and Vero Bump detection and display (page 35). 

• Thermal sensors, which monitor camera temperature levels so that you 

are warned of any changes in temperature that could affect the system 

status. For more information, see Vero temperature sensor display (page 

37).

To connect Vero cameras to the host PC, Vicon offers a range of options, 

depending on the number of cameras you want to use and whether you are 

adding them to an existing Vicon system. To determine the most 

appropriate switch for your system, contact your local Vicon Sales 

representative.

For synchronization to third-party devices and timecode, together with 

connections for analog devices, you can add a Vicon Lock+ to your Vero 

system.

Vicon Vero cameras can be used in the same system as Vicon T-Series, 

Bonita and Vantage cameras, but note that they cannot be connected to a 

Giganet.

In addition to working with current Vicon Tracker, Vicon Vero cameras can 

also be used with the Vicon Control app.

For instructions on setting up Vicon Vero systems, see the PDF Vicon Vero 

Quick Start Guide, which you can download from the Vicon website4.

https://docs.vicon.com
https://docs.vicon.com
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Vero camera status LEDs

• Location: Camera'sProperties pane > Settings section

  

To help you monitor the status of the cameras, they are fitted with status 

LEDs. Two pairs of tri-color LEDS provide feedback on camera operation, 

one pair on either side of the camera, and the second pair on either side of 

the strobe.

To change the display of camera status information:

1. In the System Resources list, select a camera (or all cameras).

2. In the Settings section of the Properties pane, select or clear Enable 

LEDs.

With Enable LEDs selected, while the camera is booting, the status LED 

color changes from yellow during booting, to red when booting is 

complete.

When the cameras are communicating with Tracker, the status LEDs 

turn blue.
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After the camera has booted, you can check the cameras' status by 

observing the status LEDs on each camera, in addition to monitoring the 

camera status in Tracker.  

Color Status

Blue Enabled (default)

Red Not contributing

Red (flashing) Bumped

Off Disabled

Magenta Selected

Off Calibration (Wand count == 0)

Magenta (flashing, period 

decreases with wand count)

Calibration (0 < Wand count < 

Required wands)

Green Calibration (Wand count >= 

Required wands)

Cyan Automasking

Off Status LEDs disabled

Note

In certain camera modes and in certain system configurations, the 

status LEDs on the camera are automatically turned off to ensure 

maximum power is available to the strobe. 
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Vero Tap to Select camera feature

• Location: Camera's Properties pane > Settings section

Vicon Vero cameras provide a Tap to Select feature, which enables you to 

lightly tap the camera in the volume to select it (and deselect the other 

cameras). This is useful, for example, when you are setting up cameras, 

before they are calibrated. The Tap to Select feature is on by default.

To turn Tap to Select on or off:

1. In the System Resources list, select the required camera.

2. In the Properties pane, go to the Settings section and select or clear 

Enable Tap to Select.

Note that when Enable Accelerometry is selected, if you tap a camera too 

hard, or if the camera is accidentally knocked, a calibrated camera is 

reported as 'bumped', that is, the camera’s status LEDs flash red and in 

Tracker, the Status section in the Properties pane for the relevant camera 

displays a check mark in its Bumped check box.

You can remove a camera’s Bumped status in Tracker. If this is a frequent 

occurrence, you can change its sensitivity to being tapped by reducing the 

Bump Detection Sensitivity. For more information, see the following 

section.
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Vero bump detection and display

• Location: Camera's Properties pane > Settings section and

Camera's Properties pane > Status section  

 

When Enable Accelerometry is selected (its default status), bump detection 

works on calibrated cameras to alert you when they have moved from their 

calibrated positions.
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To turn bump detection on or off:

1. In the System Resources pane, select a camera (or all cameras).

2. In the Properties pane, expand the Settings section and select or clear 

Enable Accelerometry.

When Enable Accelerometry is selected, if a calibrated camera is 

accidentally knocked,  the camera's status LEDs indicate that it is a 

bumped camera by flashing red and in Tracker, the camera’s Bumped

check box (in its Status properties) displays a check mark.

To change the sensitivity of the accelerometer:

1. In the System Resources list, select the required camera (or all cameras).

2. In the Properties pane, go to the Status section and in the Bump 

Detection Sensitivity pull-down, select a different option.

To clear a camera's Bumped status:

For a single camera: 

1. In the System Resources list, select the bumped camera.

2. In the Properties pane, go to the Status section and clear the Bumped

check box.

For all cameras:

Press Ctrl+Shift+B

Note the following limitations:

• Bump detection is active only on calibrated cameras.

• Bump detection cannot detect movement that does not change the local 

gravity vector, for example. slow translation with no rotation; rotation 

about the G-vector.

• Bump detection cannot detect movements that occur when the camera 

is not connected to a live system.

• The camera is detected as bumped when the reading from the 

accelerometer is sufficiently different from the last reading. Therefore 

gradual changes (for example, a slipping camera mount) may not be 

detected until they are large enough to trigger a new notification.
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Vero temperature sensor display

• Location: Camera's Properties pane > Hardware section > Camera Body 

Temp 1 and Camera Body Temp 2 

Significant changes in camera temperature can have small effects on the 

camera's lens. Camera calibrations take into account lens intrinsics. 

Changes in these intrinsic properties can have small impacts on overall 

data quality.

However, note that large temperature changes generally result in only very 

small data effects. Temperature monitoring is made available to optimize 

calibration-to-collection consistency.

Vicon Vero cameras have on-board temperature sensors. These sensors 

enable you to determine when cameras have reached a stable temperature 

from a cold start and to observe any change in camera temperature 

(possibly associated with environmental changes).

The data for the onboard sensors is displayed in the Hardware section. A 

numeric indicator (in degrees Celsius) and a colored temperature indicator 

is displayed for each sensor. The color of the indicator changes to reflect a 

change in temperature: yellow (warming up to the temperature specified by 

the lower bounds), green (between the specified upper and lower bounds) 

or red (overheated above the upper bounds).

Because Vicon motion capture cameras are used in a wide variety of 

environments, a stable camera temperature will be different for different 

users. The Camera Temperature Range option enables you to set values 

that are representative of your working environment.
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You can change the upper and lower bounds of the Camera Temperature 

Range in the Options dialog box (F7).
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Derivatives included in VRPN output
Derivatives of pose data are now automatically supplied as part of VRPN 

output.

For greater reliability and robustness, VRPN clients that are able to make 

use of velocity and acceleration data can use this information directly from 

Tracker's VRPN output, rather than having to calculate this on the client 

side.

This is useful, if, for example, you want to use Vicon data within a dead 

reckoning algorithm, or other prediction algorithm, to estimate pose at a 

time that may or may not coincide with a Vicon frame.
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Quaternion output for CSV export
Tracker 3.3 offers an additional Quaternion option for CSV export.

To use quaternion angle representation:

1. Prepare your data for CSV export as described in CSV Export (page 42).

2. Click the Angle Representation list and select Quaternion.

When you export the file, angles are exported as quaternions instead of 

Helical angles.
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Tracker 3.2 new features and functions
New features including the following have been added to Vicon Tracker 3.2:

• Offline processing (page 41)

• CSV export (page 42)

• New sensor windowing display (page 45)

• Improved floor plane calibration (page 47)

• Track mode now auto enabled (page 48)

• Instant auditory feedback (page 49)

Offline processing

• Location: Resources pane > Recording tab > Playback section

In Vicon Tracker 3.2, the playback of offline data has been completely 

reworked to provide better performance and closer simulation of realtime 

tracking. You will find this feature useful for simulating a live system, for 

example, if you are developing and/or configuring your own software that 

requires Tracker data as input. You can also use this feature to perform 

offline analysis of Tracker data with your own software tools.

If you change the filtering of the offline data, click the Reprocess Trial

button to recalculate your saved data. 
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To use offline processing:

1. On the Recording tab, in the Recording section, ensure that the relevant 

Location setting is selected (Shared or Private), depending on the option 

chosen for the trial you want to load.

2. In the Playback area, click Load Trial to locate the last saved trial. If you 

want to load a different trial, browse to the appropriate location. Click 

Open.

The recorded trial is loaded, a time bar appears beneath the view pane 

and Tracker automatically enters Offline mode (if this was not already 

selected).

3. If required, on the time bar select the range that is of interest.

4. On the time bar, click the Play button. To stop or pause the replay, click 

Stop or press the space bar on the keyboard. To view a particular part of 

the trial, drag the slider along the time bar, or to move through the trial, 

press the forward or back arrow keys.

A progress bar is displayed while the file is processed.

Objects are tracked and data is output from Tracker as if it were coming 

from a live system.

5. To export the data to your chosen format, in the Export CSV section, 

select the required options and click Start. For more information, see 

CSV export (page 42).

CSV export

• Location: Resources pane > Recording tab > Export CSV section

The new CSV (comma-separated values) export feature enables you to 

export saved trial data to a plain text file, saved in CSV format. 
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To export processed Tracker data to a CSV file:

1. Ensure you have loaded and processed the required data, as described in 

Offline processing (page 41).

2. On the Recording tab, expand Export CSV, display the Advanced

parameters and change their settings as required:

• Flename Do one of the following:

• Accept the default Current Trial setting; or

• To use a different path and/or filename, click the ellipsis (...). 

You can then browse to another location and/or enter the 

required file name, including its extension, for example 

my_trial.csv.

• First Frame and Last Frame If required, change these to specify the 

range that you want to export.

• Delimiter Do one of the following:

• Click to choose the delimiter of the exported data, selecting 

either commas, tabs, or line feeds/carriage returns; or

• To use a different delimiter, click the downward arrow and clear 

the Macro check box. You can then edit the Delimiter field to 

specify a combination of ASCII characters (maximum of two 

characters).

• Local Numeric Format If you want the exported data to use the local 

language float number format, select this check box.

• Devices for Export Do one of the following:

• Click to choose to export either no objects (None, the default 

option), only the selected objects, or all objects; or

• To select from a list of available devices, click the downward 

arrow, and clear the Macro check box.

• Objects: Do one of the following (active objects only):

• Click to choose to export either all objects (All, the default 

option), only the selected objects, or none.
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• To use the wildcard * to specify all objects, click the downward 

arrow and clear the Macro check box. You can also edit the 

Objects field to provide a list of objects (use the object names 

that appear in the System tree), separated with commas.

• Unlabeled Trajectories: If selected, unlabeled marker trajectories are 

exported.

3. To begin the export, click Start.

You can examine the exported data in your spreadsheet program.



What's new 
in Tracker 
3.7? 

New features and functions

Vicon Motion Systems Ltd. 22-Oct-2018 Page 45 of 95

New sensor windowing display

• Location: Options dialog box (F7) > Camera Limits option > Sensor 

Window property; or

• Location: Camera view > Display camera sensor window buttonThe 

windowed area is indicated by a rectangle within the Camera view, 

showing the size and position of the active window on the camera 

sensor.

 
The windowing display is visible in the Camera view, in the 3D Overlay

view and in Rotated view. 

Using Tracker 3.2 with Vicon Vantage or MX T-Series cameras, you can now 

view the windowing that occurs at higher frame rates.
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To toggle the display of windowing:

• On the Camera view toolbar, click the Display camera sensor window

button.

or

• In the Options dialog box (F7), click the Camera Limits option and in the 

Properties pane, select the Sensor Window property

You can gain instant feedback on the area that is captured and save room 

on the screen by zooming in to the sensor window.

Note: For captures made in versions of Tracker before 3.2, zooming in to 

the sensor window applies to Live mode only.

To zoom in to the displayed sensor window:

1. Ensure sensor windowing is displayed (see above).

2. In a Camera view, from the View menu, select Zoom to Window.

To turn on Zoom to window for all windows:

• Press the hot keys: Ctrl+Shift+Z.
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Improved floor plane calibration
To ensure that your coordinate system is accurately aligned with the floor 

of the capture volume, you can now adjust the position of the floor plane, 

using markers in the volume to automatically define it.

To calibrate the floor plane:

1. Scatter a quantity of the same size Vicon markers across the floor of 

your capture volume. If you want Tracker to automatically recognize 

these markers as floor plane markers, ensure that they outnumber any 

other groups of markers (e.g, markers on a wand or markers that were 

used to focus cameras, etc).

2. Complete the usual system calibration procedure to set the volume 

origin.

3. On the Calibrate tab, expand Set Volume Origin and display the 

Advanced properties.

4. Next to Set Floor Plane, ensure that the options are as required:

• Auto detect: Markers are automatically detected, based on the marker 

group that defines the plane with the most markers. If, when you click 

Start, the wrong markers are selected in the 3D Perspective view, you 

can add or remove markers in the volume until selection is as required. 

To ensure that the tolerance setting (in mm), which specifies the 

height of the group of markers that define the floor plane, is as 

required, click the drop-down arrow next to Auto Detect.

• Offset: Set the amount (in mm) by which to adjust the floor plane 

(default is zero) in X Y and Z planes. The offset is applied after you 

have set the origin using the Set Floor Plane setting.

5. Click the Start button in the Set Floor Plane line.

The button toggles to its Stop setting.

6. After a few seconds, click the Stop button.

In the 3D Perspective view the cameras shift as a group slightly along 

one or more rotation axes to better reflect an average of the markers 

scattered across the floor.

Your Vicon cameras are now calibrated and ready to capture data.
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Track mode now auto enabled

• Location: Resources pane > Objects tab> Object Tracking Mode section

Track mode was introduced in Tracker 3.0 (see New Track mode minimizes 

output latency (page 72)). To save you from having to turn Track mode on and 

off, it is now on by default when objects are activated or created (including 

when Tracker is started if active objects are present).

It is off by default when no active objects are present.

If this behavior is undesirable (for example, if you are creating multiple 

objects), you can toggle tracking off or on by clearing or selecting Auto 

Enable.
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Instant auditory feedback

• Location: Windows menu > Sounds option (or press F6) > Enabled option

Tracker 3.2 provides you with the option to plays sounds through your PC's 

speakers to alert you when a Tracker event has taken place (for example, 

operation completion, system status, and issues). This keeps you informed 

of system status while you're still in the volume, so that you don't have to 

spend time returning to the PC to look at the screen.

When sounds are enabled, by default Tracker uses speech sounds to alert 

you to the following events:

• Calibration start

• Wand Wave complete

• Calibration complete

• Calibration failed

• Origin set

• Capture started

• Capture ended

• Capture failed

• Camera bumped

• Pipeline ended

• Pipeline failed

Tracker is supplied with a set of default sound files (.wavs). You can modify 

the sounds that are used for each event and you can enable all sounds or 

enable sounds individually.

To enable sounds and change these settings:

1. Press F6; or

On the Windows menu, click Sounds.

2. In the Sounds dialog box, select Enabled.
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To choose one of the other sounds supplied with Tracker, click the drop-

down arrow and select the required sound from the list.

To substitute your own sounds for those supplied with Tracker, click the 

relevant ellipsis (...) and enter or browse to the location of the required .wav 

files.

To disable one or more sounds, click the relevant drop-down arrow and 

select (None) from the list.

To disable all sounds, in the Sounds section, clear the Enabled check box.
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Tracker 3.1 new features and functions
New features including the following were added to Vicon Tracker 3.1:

• Compatibility with Vicon Vantage systems (page 51)

• Compatibility with Vicon Lock+ (page 59)

• Compatibility with Vicon Control (page 60)

Compatibility with Vicon Vantage systems
The latest version of Tracker is compatible with the Vicon Vantage range of 

cameras and hardware, enabling you to benefit from the power and 

usability of the new system.

Vicon Vantage includes three camera models, beginning with the V5, which 

offers up to 420 fps with 5 megapixel resolution, the V8 at up to 270 fps 

with 8 meegapixel resolution and the V16, which can provide up to 120 fps 

with 16 megapixel resolution. 
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In addition, all three models offer:

• A front-facing OLED display as well as side-mounted status lights, which 

give clearly visible camera ID information and system feedback. For more 

information, see New camera status LEDs and OLED display (page 53).

• An accelerometer, which enables you to select a camera in the volume 

simply by tapping it, and which monitors the camera position to alert you 

if any cameras are accidentally knocked or moved from their intended 

positions. For more information, see New Tap to Select feature (page 55) 

and New bump detection and display (page 56).

• Thermal sensors, which monitor camera temperature levels so that you 

are warned of any changes in temperature that could affect the system 

status. For more information, see New temperature sensor display (page 

58).

With a new Vicon-provided PoE+ switch, you can connect up to 12 Vicon 

Vantage cameras to the Vicon Vantage host PC. The system can be 

expanded to add more cameras or additional hardware by connecting 

further PoE+ switches.

For synchronization to third-party devices and timecode, together with 

connections for analog devices, you can add a Vicon Lock+ (see 

Compatibility with Vicon Lock+ (page 59)).

For more information on Vicon Vantage systems, see the Vicon Vantage 

Quick Start Guide and the Vicon Vantage Reference.
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New camera status LEDs and OLED display

• Location: Camera's Properties pane > Settings section

To help you monitor the status of Vicon Vantage cameras, the cameras 

include status LEDs and an OLED display:

• Two pairs of tri-color LEDS provide feedback on camera operation, one 

pair on either side of the camera, and the second pair on either side of 

the strobe.

• The display on the front of the Vicon Vantage strobe, combined with the 

status LEDs' color, gives information about the current camera status.

Under normal conditions (unless a connected application changes the 

display, and unless the display has been disabled in Tracker), the display 

changes to reflect the camera status.

To change the display of Vicon Vantage camera status information:

1. In the System Resources list, select a camera (or all cameras).

2. In the Settings section of the Properties pane, select or clear Enable 

LEDs and/or Enable Display.

With Enable LEDs and Enable Display selected, while the camera is 

booting, the OLED display shows the Vicon logo and the status LED 

color changes from yellow during booting, to red when booting is 

complete.

When the cameras are communicating with Tracker, the status LEDs 

turn blue.
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The display changes to reflect the camera's status, giving information 

about camera status, for example when the camera has finished booting, 

its calibration status, and whether it has been moved since calibration.

When Enable Display is cleared, the display is blank.

When Enable Accelerometry is selected (see New bump detection and 

display (page 56)), the image on the display rotates based on the orientation 

of the camera.

After the camera has booted, you can check the cameras' status by 

observing the status LEDs and the OLED display on each camera. You can 

also monitor the camera status in Tracker.

For more information about the status LEDs, see the Vicon Vantage 

Reference.
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New Tap to Select feature

• Location: Camera's Properties pane > Settings section

Vicon Vantage cameras provide a Tap to Select feature, which enables you 

to lightly tap the camera in the volume to select it (and deselect the other 

cameras). Enable Tap to Select is on by default.

To turn Tap to Select off or on:

1. In the System Resources list, select the required camera.

2. In the Properties pane, go to the Settings section and clear or select 

Enable Tap to Select.

Note that when Enable Accelerometry is selected, if you tap a calibrated 

camera too hard, the camera is reported as 'bumped' (that is, its status 

LEDs and OLED display (if enabled) indicate that it is a bumped camera).

You can remove the camera's bumped status in Tracker. If this is a frequent 

occurrence, you can change its sensitivity to being tapped by reducing the 

Bump Detection Sensitivity.

For information on removing a camera's bumped status and changing Bump 

Detection Sensitivity, see New bump detection and display (page 56).
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New bump detection and display

• Location: Camera's Properties pane > Settings section and Camera's

Properties pane > Status section

 

In addition to the Tap to Select feature (see above (page 55)), Vicon Vantage 

cameras also provide bump detection.

When Enable Accelerometry is selected, (its default state) bump detection 

works on calibrated cameras to alert you when they have moved from their 

calibrated positions. (This setting also turns on or off the auto-rotation of 

the display on Vantage cameras.)

To turn bump detection off or on:

1. In the System Resources pane, select a camera (or all cameras).

2. In the Properties pane, expand the Settings section and clear or select 

Enable Accelerometry.

When Enable Accelerometry is selected, if a calibrated camera is 

accidentally knocked, its display changes.

 
In Tracker, the camera's Bumped check box (in its Status properties) 

displays a check mark.
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To change the sensitivity of the accelerometer:

1. In the System Resources list, select the required camera.

2. In the Properties pane, go to the Status section and select a different 

option in the Bump Detection Sensitivity pull-down.

To clear a camera's Bumped status:

For a single camera:

1. In the System Resources list, select the bumped camera.

2. In the Status section of the Properties pane, clear the Bumped check 

box.

For all cameras:

• Press Ctrl+Shift+B

Note the following limitations:

• Bump detection is active only on calibrated cameras.

• Bump detection cannot detect movement that does not change the local 

gravity vector, for example. slow translation with no rotation; rotation 

about the G-vector.

• Bump detection cannot detect movements that occur when the camera 

is not connected to a live system.

• The camera is detected as bumped when the reading from the 

accelerometer is sufficiently different from the last reading that was 

sent. Therefore gradual changes (for example, a slipping camera mount) 

may not be detected until they are large enough to trigger a new 

notification.
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New temperature sensor display

• Location: Camera's Properties pane > Hardware section > Strobe Temp, 

Camera Body Temp 1 and Camera Body Temp 2 

Significant changes in camera temperature can have small effects on the 

camera's lens. Camera calibrations take into account lens intrinsics. 

Changes in these intrinsic properties can have small impacts on overall 

data quality. However, note that large temperature changes generally result 

in only very small data effects. Temperature monitoring is made available to 

optimize calibration-to-collection consistency.

Vicon Vantage cameras have on-board temperature sensors. These onboard 

temperature sensors enable you to determine when cameras have reached 

a stable temperature from a cold start and to observe any change in 

camera temperature (possibly associated with environmental changes).

The data for the onboard sensors is displayed in the Hardware section. A 

numeric indicator (in degrees Celsius) and a colored temperature indicator 

is displayed for each of the sensors. The color of the indicator changes to 

reflect a change in temperature: yellow (warming up to the temperature 

specified by the lower bounds), green (between the specified upper and 

lower bounds) or red (overheated above the upper bounds).

Because Vicon motion capture cameras are used in a wide variety of 

environments, a stable camera temperature will be different for different 

users. The Camera Temperature Range option enables you to set values 

that are representative of your laboratory environment.

You can change the upper and lower bounds of the temperature range in 

the Options dialog box (F7).
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Compatibility with Vicon Lock+
Tracker 3.1 is compatible with Vicon Lock+, a new Vicon connectivity 

device that facilitates the integration of synchronous third-party 

equipment with Vicon Vantage and Vicon Bonita cameras by providing or 

receiving synchronization and/or timecode.

It also provides connectivity for third-party analog capture sources, such as 

force plates, EMG equipment, and generic devices.

When a Lock+ is connected into a compatible Vicon system, it appears in 

the System Resources list in the same way as other Vicon connectivity 

devices.

To access its properties and settings, in the System Resources list, click the 

name of the Lock+ device.

You can then access its controls in the System Resources list.

For information on connecting a Vicon Lock+ into a Vicon camera system, 

see the Vicon Lock+ Quick Start Guide and the relevant specification sheet.

Important

The use of Vicon Lock+ is supported for Vicon Vantage and Vicon 

Bonita camera systems only.
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Compatibility with Vicon Control
With the latest version of Tracker, you can use the Vicon Control app, 

currently available on iOS 8 devices, to set up, calibrate, and capture with a 

Vicon Vantage, T-Series or Bonita system.

Control connects wirelessly to Vicon Tracker and streams camera data to 

your mobile or tablet, enabling a single user to change camera settings, 

calibrate the system, and start or stop capture from anywhere in the 

volume.

Vicon Control features include:

• The ability to change camera settings, calibrate, and start and stop 

capture with its intuitive single-handed dial

• View adjustments to the aperture and focus settings by selecting the 

camera from Control

• Select a Vantage camera and display it automatically using Tap to Select

Note that Vicon Control is compatible with the following devices:

• Phone 5, 5C, 5S, 6, 6+

• iPad Air, iPad Air 2, iPad Mini 2, and iPad 3
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Connect Vicon Control

Before you can use your iOS device with Tracker, you must pair it with the 

PC that is running Tracker (the Vicon host PC).

To connect an iOS device running the Vicon Control app to Tracker on a 

Vicon host PC:

1. Ensure that your iOS device is connected to a Wifi access point that is 

on the same subnet as the Vicon host PC.

2. On the Vicon host PC, ensure that the required connection is used, that 

Tracker is running, and the system is connected.

3. On the device, open the Vicon Control app.

The connection to Tracker is displayed on the initial Control screen:

4. Tap the Tracker icon.

You are alerted that you must authorize the connection on the Vicon 

host PC before you can continue.

In Tracker on the Vicon host PC, an authorization request is displayed:
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5. To use the same connection in future, select Remember this choice for 

future connection attempts. To let Control access Tracker, click Allow.

On the iOS device, a screen similar to the following is displayed:

6. To select a camera and display a camera view, tap the bottom of the 

screen.

Swipe the camera view right or left to change to the next or previous 

camera. Use stretch and pinch to zoom in and out.

To access the dial control, tap and hold in a selected camera view.

Use the dial to view and change settings, calibrate and capture.

Tip

If later you need to revoke authorizations for Vicon Control, on 

the Window menu in Tracker, click Reset Control Authorization. 

This revokes all stored authorizations.
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Tracker 3.0 new features and functions
New features including the following were added to Vicon Tracker 3.0:

• Filtering and smoothing (page 63)

• Choose different smoothing options for each object (page 64)

• Jitter reduction (page 66)

• Improved processing (page 67)

• Access Tracker data from Simulink (page 67)

• Other enhancements in Vicon Tracker 3.0 (page 68)

Filtering and smoothing

• Location: Resources pane > System tab > Local Vicon System > 

Properties pane > Object Tracking section

Vicon Tracker 3.0 offers new filtering options to detect static objects and 

minimize jitter caused by marker occlusion.

In the Properties pane for Local Vicon System, the new Object Tracking

section contains the System-wide Object Filter dropdown list.
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To apply a filter to all objects, choose one of the options:

• None: No filtering of any objects, unless object-specific filtering is 

applied: see Choose different smoothing options for each object (page 64).

• Motion Model: Enables Tracker to detect static objects. When selected, 

Tracker outputs a constant position and orientation for an object from 

the time it is detected as not moving to the time it resumes motion. Use 

this option to clamp the position of an unmoving object to its previous 

known position.

• Bias Tracking: Applies a smoothing filter that tracks systematic errors in 

the camera measurements to minimize motion jitter when markers 

become occluded in the camera views.

Choose different smoothing options for each object

• Location: Resources pane > Objects tab > Filter Mode Preset section

Vicon Tracker 3.0 enables you to apply a One Euro low-pass smoothing 

filter to a selected object. Where you have multiple objects, you can apply 

different filtration settings to each object, enabling you to tailor the 

amount of filtration to the motion of the specific object.

To assist you in setting appropriate filtration for your objects, Tracker 3.0 

provides the following commonly used filter mode presets:

• None: Apply no object-specific filtering to the selected object.

• HMD: Apply settings normally appropriate for head-mounted devices.

• InteractionDevice: Apply settings normally appropriate for Vicon Apex 

devices.

• General: Use as a general-purpose filtration type.
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5 http://www.lifl.fr/~casiez/1euro/

If none of the supplied filter mode presets is suitable for your application, 

you can also create and save your own custom filter mode presets, so that 

you can quickly and accurately apply them to other objects, as required.

To apply filtering to a selected object:

1. In the Objects tree at the top of the Objects tab, ensure that the object 

to which you want to apply the filter is selected.

2. Depending on whether you want to use an existing filtration type or 

create your own, do one of the following:

• If you want to use one of the existing filter types, in the Filter Mode 

Preset section, select the required filter from the dropdown list and 

save the object as described in step 5.

or

• If the required filtration type does not exist, in the Filter Mode Preset

section, click Manage Presets and in the Filter Presets dialog box, 

enter a name in the Create New Preset box and then click Add.

3. In the Filter Presets section, ensure the new preset is selected, then in 

the Smoothing section, change the Translation and Rotation properties 

as required:

a. With Translation Beta set to zero, change the value of Translation Min 

Cut-Off to eliminate jitter during very slow movements.

Note that decreasing the value of Translation Min Cut-Off reduces 

jitter but increases lag.

b. When you have finished adjusting the Translation Min Cut-Off value, 

increase the value of Translation Beta by very small increments to 

eliminate lag during faster movement.

Note that 0 = filtering on all translation motion; 1 = filtering on very 

slow translation motion only.

c. Follow the same procedure for adjusting the Rotation Min Cut-Off

and Rotation Beta.

For detailed information on the One Euro filter and how to adjust 

these settings, visit www.lifl.fr/~casiez/1euro/5.

d. When you have finished adjusting the properties, click Close.

http://www.lifl.fr/~casiez/1euro/
http://www.lifl.fr/~casiez/1euro/
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4. On the Objects tab, make sure that in the Filter Mode Preset section, the 

required filter is displayed for the selected object.

5. Save the object by right-clicking it the Objects list and selecting Save 

Object from the context menu.

Tracker saves the contents of the object in a .vsk file in the Objects folder.

Jitter reduction

• Location: Resources pane > System tab > Local Vicon System > 

Properties pane > System section > Low Jitter option

To enable you to minimize jitter in marker positions while tracking objects, 

a new Low Jitter option is now available in System properties.

This option sets the Grayscale Mode for all cameras to Only (this is 

necessary to enable jitter reduction to work), and applies Tracker's jitter 

reduction algorithms to the current data. This reduces noise in the data by 

using advanced centroid fitting and other jitter reduction measures.

Tip

To apply a filter to an Apex device, select the device and in the 

General section of the Properties pane, from the Filtering Type

list, select the required filtering type.



Caution

Low jitter mode is more sensitive to bandwidth limitations than 

previous versions of tracking and its effectiveness is related to 

system size. For further information on the impact of using low 

jitter mode with your system, contact Vicon Support6.



mailto:support@vicon.com
mailto:support@vicon.com
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Improved processing
Vicon Tracker 3.0 has been re-engineered to significantly reduce 

processing latency and improve processing frame rate, even with high 

numbers of tracking objects and cameras, by making full use of modern 

multiple-core CPUs.

Improvements in processing rate mean that end-to-end latency may also be 

reduced by increasing the Vicon camera frame rate.

Access Tracker data from Simulink
See Accessing Vicon Tracker data from Simulink, in the Vicon Tracker User 

Guide.
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Other enhancements in Vicon Tracker 3.0
Further enhancements and updates including the following have been 

made in Tracker 3.0:

• • Calibration error displayed in millimeters (page 68)

• Easier setup of Apex devices (page 69)

• New hotkey/Tracker shortcut (page 70)

• Auto-naming of new objects (page 70)

• Additional VRPN output (page 70)

• Easier upgrading (page 71)

• Improved analysis and troubleshooting for captured data (page 71)

• New Track mode minimizes output latency (page 72)

• Set Camera view background to Threshold value (page 72)

• Automatic selection of cameras and view for masking and calibration

(page 73)

• Change in Shared data locations (page 74)

• Change in default Minimum Cameras to Start Trajectory (page 74)

Calibration error displayed in millimeters

• Location: Resources pane > Calibration tab > Camera Calibration 

Feedback section > World Error column

In Tracker 3.0, the World Error column in the Camera Calibration Feedback

section displays the calibration error in millimeters, giving you a sense of 
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how much the errors in the camera contribute to the reconstruction of 

object pose error.

World error is calculated per camera from the Image Error in pixels and the 

distance of the camera to the center of the volume. Cameras further away 

display a higher World Error than cameras closer to the center of the 

volume with the same image error.

Easier setup of Apex devices

• Location: Resources pane > System tab> Devices node > Apex device

node > Properties pane > General section

In the Properties pane for the selected device, the General section enables 

you to select from the following orientation options for the device 

coordinate system:

To facilitate the setting up of Apex devices within a virtual environment, 

Vicon Tracker incorporates options for the device axes.

• Y-Back Z-Up

• Y-Forward Z-Up
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• X-Back Z-Up

• X-Forward Z-Up

This property is saved in the .system file.

The General section also contains the new Filtering Type field, where you 

can specify the filtering type for the selected Apex device. For more 

information on filtering types, see Choose different smoothing options for 

each object (page 64).

New hotkey/Tracker shortcut

A new hotkey (CTRL+E) creates a named object from selected markers.

This provides the same functionality as pressing the Create button in the 

Create Object section of the Objects tab.

Auto-naming of new objects

• Location: Resources pane > Objects tab > Create Object section

When you enter a name in the Create Object text box and click Create, the 

name is automatically incremented by 1, so that, to create another object 

with the default name of ObjectName_n, you can just select the required 

markers and click Create.

Additional VRPN output

• Location: Resources pane > System tab > Local Vicon System > 

Properties pane (to see all options, click Show Advanced) > VRPN Stream

section

If you are rendering the same object to different display types (for example, 

to both a large screen and an immersive environment such as a head-
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mounted display), to obtain smooth visualization on both display types, you 

are likely to need to apply different amounts of filtration for each.

To enable you to do this, Tracker 3.0 provides a second set of VRPN 

Trackers, which are output with the existing ones. For easy identification, 

the names of this second set of VRPN Trackers are suffixed with _2.

The second set of VRPN Trackers includes customizable One Euro filtering. 

(For information on adjusting the filtering parameters, see Choose different 

smoothing options for each object (page 64).)

Easier upgrading

To make data migration easier between Tracker upgrades, you are given the 

option of migrating and updating shared user data stored in the old 

location (ProgramData\Vicon\Tracker) into the new location (C:

\Users\Public\Documents\Vicon\Tracker3.x).

Improved analysis and troubleshooting for captured data

• Location: Resources pane > Recording tab

For each trial recorded, at least three files are saved: .x2d, .system, and .xcp 

files. With Vicon Tracker 3.0, an .x2d file containing the latest calibration 

data, of the format LatestCalibration yyyymmddnnnnnn.x2d, is also saved 

in the same location as the .x2d containing the recorded trial data.

The file that contains the calibration data can be useful for data analysis 

and troubleshooting. When you have captured a trial, you can find the 

calibration .x2d in the same location as the .x2d of the recorded trial.
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New Track mode minimizes output latency

• Location: Resources pane > Objects tab> Object Tracking Mode section> 

Track mode button

To minimize output latency, the new Track mode prevents the display of 

unlabeled markers in the 3D Perspective view. Because viewing unlabeled 

reconstructions requires additional processing, for lowest output latency, 

when you have finished creating objects, click the Track button to change 

to Track mode.

To turn off the display of unlabeled reconstructions:

• In the Resources pane, click the Objects tab and ensure that in the 

Object Tracking Mode section at the bottom of the tab, Track mode is 

selected.

When Track mode is selected, the Track button is green. This mode 

switches off the display of unlabeled reconstructions in 3D Perspective 

view.

Set Camera view background to Threshold value

• Location: Options dialog box > General View Options section> Threshold

option

To help you to determine the most effective threshold setting for grayscale 

blobs, you can set the background color of the Camera view to the value of 

the Threshold control in the Centroid Fitting section of the Properties

pane. To do this:

1. Open the Options dialog box (F7), and in the General View Options, 

select Threshold.

2. On the System tab, select the camera and ensure that the view pane is 

displaying a Camera view.
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3. For each camera, in the Properties pane:

a. In the Settings section, ensure Grayscale Mode is set to All.

b. In the Centroid Fitting section, adjust the camera's Threshold settings 

to obtain the clearest possible view of the blobs, with minimal 

flickering in the Camera view.

Automatic selection of cameras and view for masking and calibration

• Location: Resources pane > Calibrate tab > Create Camera Masks and 

Calibrate Cameras sections > Start button

A new time-saving feature of Tracker 3.0 improves the process of masking 

and calibration.

When you begin masking or calibration by clicking the Start button in the

Create Camera Masks or Calibrate Cameras sections, the cameras are 

automatically selected and the view pane displays Camera views of all the 

selected cameras.
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Change in Shared data locations

In Vicon Tracker 3, data is saved in the following folders:

• Shared files are saved in the appropriate sub-folder in: C:

\Users\Public\Documents\Vicon\Tracker3.x\

• Private files are saved in the appropriate sub-folder in: C:

\Users\UserName\AppData\Roaming\Vicon\Tracker3.x\

Change in default Minimum Cameras to Start Trajectory

• Location: Resources pane > System tab> Local Vicon System node > 

Properties pane > Reconstruction section

The Local Vicon System property Minimum Cameras to Start Trajectory

specifies the number of cameras that must see the same marker to create a 

new reconstruction and potentially form a new trajectory.

In Tracker 3.0, the default value for this property is 3 (ie three cameras), so 

if you are using a two-camera system, ensure you change the value to two 

before starting to work with Tracker.
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Vicon Tracker addressed issues

For information on issues addressed in each point release of Vicon Tracker 

3, see:

• Addressed issues in Vicon Tracker 3.7 (page 76)

• Addressed issues in Vicon Tracker 3.6 (page 77)

• Addressed issues in Vicon Tracker 3.5 (page 78)

• Addressed issues in Vicon Tracker 3.4 (page 79)

• Addressed issues in Vicon Tracker 3.3 (page 80)

• Addressed issues in Vicon Tracker 3.2 (page 82)

• Addressed issues in Vicon Tracker 3.1 (page 83)

• Addressed issues in Vicon Tracker 3.0 (page 84)
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Addressed issues in Vicon Tracker 3.7

Record 

number

Description

TRAC-2166 Tracker no longer crashes when opening the Capture 

panel in Control 1.3
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Addressed issues in Vicon Tracker 3.6

Addressed issues in Vicon Tracker 3.6.1

Record 

number

Description

TRAC-2067 Objects loaded/created with spaces no longer produce 

unintended results.

TRAC-2099 Default reconstructions for 3.6 now produce the 

expected results.

Addressed issues in Vicon Tracker 3.6.

Record 

number

Description

TRAC-2025 Multiple small objects that are close together can now be 

tracked simultaneously.

TRAC-1995 

and 

TRAC-1992

The C++ example code that is supplied with the Vicon 

DataStream SDK and described in Accessing Vicon 

Tracker data from Simulink, now compiles and links 

successfully.  

TRAC-1856 Improvements in labeling for large object counts.
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Addressed issues in Vicon Tracker 3.5

Record 

number

Description

TRAC-1788 Enabling/disabling multiple selected Objects and Groups 

is now successful.

TRAC-1790 CSV export now exports unlabeled reconstructions.

TRAC-1817 Importing system files no longer results in a crashdump.

TRAC-1819 No crash on clicking Recalibrate object button.

TRAC-1847 You can now assign object filter type with previously 

problematic system files.

TRAC-1867 Tracker now takes a normal time to start when not 

connected to a network license server.

TRAC-1894 Low jitter parameters are now respected offline.

TRAC-1895 Playback no longer stops at midnight.

TRAC-1909 Apex now comes back after turning off in a live system.

TRAC-1921 Reading .xcp file containing 3-parameter Calibration 

model in older versions no longer causes incorrect 

behavior.
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Addressed issues in Vicon Tracker 3.4

Record 

number

Description

TRAC-1348 Add marker to object now works correctly.

TRAC-1549 Sound playback is not delayed.

TRAC-1742 Tracker now correctly delivers UDP items per packet.

TRAC-1755 Apex remains connected.

TRAC-1773 Revert view type no longer causes Tracker to hang.
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Addressed issues in Vicon Tracker 3.3

Record 

number

Description

TRAC-1636 The marker position parameter for objects no longer 

intermittently auto locks itself.

TRAC-1629 Improved the reliability of VPRN outputs for Apex devices 

to ensure they contain changes for button presses.

TRAC-1628 Improved the application start up time for Tracker if 

Bonjour has not been installed.

TRAC-1624 The DSP for a camera is now disabled when low jitter is 

enabled in the system file.

TRAC-1613 Corrected a behavior where the Set Origin command fails 

when the wand type is set to 5 Marker Wand & L-Frame.

TRAC-1606 Euler angles within the CSV Export operation are now 

output as axis angles.

TRAC-1509 The CSV Export operation now shows a progress bar.

TRAC-1524 You can now cancel CSV Export.

TRAC-1524 A memory leak while tracking for long periods has been 

addressed.

TRAC-1546 Calibration no longer fails silently if one or more 

disconnected cameras are present in the system.



What's new 
in Tracker 
3.7? 

Vicon Tracker addressed issues

Vicon Motion Systems Ltd. 22-Oct-2018 Page 81 of 95

Record 

number

Description

TRAC-1537 Timecode is now correctly displayed in offline.

TRAC-1530 Improved the reliability of latency metrics that are 

displayed in a Graph view for high object count & high 

frame rate.

TRAC-1518  Filtering offline now fully matches live behavior.

TRAC-1315 A behavior where you were unable to set an object’s 

marker local coordinates manually has been corrected.
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Addressed issues in Vicon Tracker 3.2
The following issues were addressed in Vicon Tracker 3.2

Record 

number

Description

TRAC-1378 Mask|Start grayed out with only three cameras.

TRAC-1362 Camera Attributes | Status | check marks in check boxes 

are difficult to see.

TRAC-1334 Pausing offline playback unlabels/labels after playback 

has paused.

TRAC-1257 Menu items have three different states.

TRAC-1082 Reconstructor can behave differently in 2.2 and 3.0.

TRAC-810 Unresponsive state switching from Perspective to Graph 

view.
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Addressed issues in Vicon Tracker 3.1
The following issues were addressed in Vicon Tracker 3.1:

Record 

number

Description

TRAC-1277 Auto masking cannot be limited to a subset of all 

cameras

TRAC-776 Analog data from Apex cuts out
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Addressed issues in Vicon Tracker 3.0
The following issues were addressed in Tracker 3.0:

Record 

number

Description

TRAC-446 Misleading units on graph when multiple analog device 

outputs are selected.

TRAC-621 Recorded trial holds old system configuration data.

TRAC-641 Tracker 2.0 | Other Devices | Add Interaction Device | Re-

adding previously seen but deleted devices can result in 

device not being added.

TRAC-648 Offline performance issues.

TRAC-705 Tracker | Options | Reflection is not working when Solid 

floor is selected.

TRAC-763 Disconnect and reconnect of multiple Apex devices 

results in differences in segment names.

TRAC-772 Tracker 2.1 | Objects | Object position and rotation 

properties are still grayed out in pause.

TRAC-773 Tracker 2.1 | Objects | Object manipulation in offline 

appears broken directly after editing.

TRAC-793 Tracker | Documentation | Using Chrome to open 

contents causes continued reloading of page.
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Vicon Tracker known issues

For information on known issues in each point release of Vicon Tracker 3, 

see:

• Known issues in Vicon Tracker 3.7 (page 86)

• Known issues in Vicon Tracker 3.6 (page 87)

• Known issues in Vicon Tracker 3.5 (page 88)

• Known issues in Vicon Tracker 3.4 (page 89)

• Known issues in Vicon Tracker 3.3 (page 90)

• Known issues in Vicon Tracker 3.2 (page 91)

• Known issues in Vicon Tracker 3.1 (page 92)

• Known issues in Vicon Tracker 3.0 (page 93)
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Known issues in Vicon Tracker 3.7
None.
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Known issues in Vicon Tracker 3.6

Record 

number

Decription

TRAC-2055 If you use variations on upper/lower case, you can create 

multiple object presets with the same name (eg, Test and 

test).

TRAC-2053 When using only one camera with an Apex device, the 

Apex is displayed intermittently.
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Known issues in Vicon Tracker 3.5

Record 

number

Description

TRAC-1924 Recalibrating with multiple cameras selected re-

calibrates only one camera.

TRAC-1923 Hang on startup with Vue/Bonita video connected.

TRAC-1922 Crash on exit if Tracker is opened on a machine already 

running Nexus.

TRAC-1794 Tracker hangs if started without a previously used dongle 

attached.

TRAC-1682 Capture/Calibration is stopped if camera errors occur.

TRAC-1229 Creation of objects cannot be undone.
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Known issues in Vicon Tracker 3.4

Record 

number

Description

TRAC-1790 CSV export doesn’t export unlabeled reconstructions.

TRAC-1794 Tracker hangs if started without a previously used dongle 

attached.

TRAC-1682 Capture/Calibration is stopped if camera errors occur.

TRAC-1229 Creation of objects cannot be undone.



What's new 
in Tracker 
3.7? 

Vicon Tracker known issues

Vicon Motion Systems Ltd. 22-Oct-2018 Page 90 of 95

Known issues in Vicon Tracker 3.3
 None.
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Known issues in Vicon Tracker 3.2

Record 

number

Description

TRAC-1540 Need to click Yes to use license for each feature when 

use trial license dialog is displayed.

TRAC-1534 Subject list drop down does not automatically resize.

TRAC-1262 Cannot add Apex if Apex has been added in a second 

system file.

TRAC-1546 Calibration fails if one or more cameras are blank.
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Known issues in Vicon Tracker 3.1

Record 

number

Description

When the system frame rate is set above 80Hz, if you 

enable Preview mode, no preview is displayed for Vantage 

cameras (the Camera view is blank). To use Preview mode 

for Vantage cameras, select a system frame rate below 

80Hz. To be addressed in a future release. T-Series 

Preview mode continues to work as expected.

TRAC-1229 Object creation cannot be undone (page 94)

TRAC-442 Rotation causes translation for an object aligned to 

global axes (page 94)

TRAC-668 Tracker fits absent Apex to objects in the capture volume

(page 94)

Cameras set to different strobe intensities cause Apex or 

Active wand to sync incorrectly with the camera system

(page 95)
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Known issues in Vicon Tracker 3.0

Record 

number

Description

TRAC-1229 Object creation cannot be undone (page 94)

TRAC-1277 Auto masking cannot be limited to a subset of all 

cameras (page 94)

TRAC-442 Rotation causes translation for an object aligned to 

global axes (page 94)

Apex jitter caused by switching between Continuous and 

Strobe mode (page 94)

TRAC-668 Tracker fits absent Apex to objects in the capture volume

(page 94)

Cameras set to different strobe intensities cause Apex or 

Active wand to sync incorrectly with the camera system

(page 95)

Apex is not compatible with VR cameras (page 95)

Analog data from Apex cuts out (page 95)
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Object creation cannot be undone (TRAC-1229)

You cannot use Undo (CTRL+Z) after creating an object.

To remove the object, delete it instead of using Undo.

Auto masking cannot be limited to a subset of all cameras (TRAC-1277)

If you select a subset of all the available cameras and click Start in the 

Create Camera Masks section of the Calibrate tab, all camera views are 

displayed and all are masked.

Rotation causes translation for an object aligned to global axes (TRAC-442)

In some circumstances (e.g, when a small object is very distant from the 

origin) rotation along a particular axis, e.g, the X axis, for an object that is 

aligned to the global axes, causes a significant translation along the Y axis.

Apex jitter caused by switching between Continuous and Strobe mode

With an Apex set to its default LED Intensity of 2 in Tracker, or if it is set to 

3, in situations where the Apex switches between being synchronized with 

the cameras and not being synchronized, it alternates between Strobe

mode (synchronized) and Continuous mode (not synchronized). This causes 

tracking to jitter.

To avoid this effect, in the General section of the Properties pane, either 

change the LED Intensity setting to 1 or select Continuous Mode. Note that 

if you select Continuous Mode, power consumption increases, causing the 

battery to be depleted more quickly.

Tracker fits absent Apex to objects in the capture volume (TRAC-668)

If an Apex is present in a capture volume containing an object such as an 

Active Wand or a rigid body plate, and you add the Apex to the System tree 

and then remove the Apex from the capture volume, Tracker may fit the 

absent Apex to an object in the capture volume.

To avoid this issue, whenever you are not using the Apex in the capture 

volume, turn it off.
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Cameras set to different strobe intensities cause Apex or Active wand to 

sync incorrectly with the camera system

When using either an Apex or an Active Wand, unwanted effects (for 

example, jitter in tracking) are caused by using cameras at different strobe 

intensities or if one or more disabled cameras is present in the capture 

volume.

To avoid this issue, ensure all cameras are set to the same strobe intensity 

and that there are no disabled cameras in the volume.

Apex is not compatible with VR cameras

To maximize battery life, the Apex does not emit both frequencies of light 

that are required to support Visible Red (VR) cameras, so the Apex cannot 

be used in systems with VR strobes.

Analog data from Apex cuts out

If an Apex is left running with Graph view displayed in Tracker, after a 

minimum period of about 10 minutes, the analog data may cut out and the 

graph view shows no Apex data.

If this issue occurs, perform a manual resync.
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